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Course Objective –  

The core objective of this e-book is to learn about Microsoft Word. This course e-

book is for students, professional or any individual who is willing to learn the 

concept of Word to create or format word documents with ease and via more 

effective way for better outcomes or productive gain. Here we learn about 

multiple features of word and dive deep much more learning.    

Preface –  

This is the first edition of book in your hands. This book provides an introduction 

about Microsoft Word and its feature to start your professional career or can 

learn these concepts to create office or project document with more ease. As 

with rapidly changing and updating world we were trying to describe every 

detail topic in this e-book. We have tries or best to make this e-book a complete 

product and it’s gratifying to know that a lot of people agree with our 

approach.  Dear reader, thank you very much for your love and faith. Your 

association makes us feel proud.                                                                                        

Copyright & Disclaimer -  

© Copyright 2018 by LearnInCreation. All content and graphics published in this e-book are the property 

of LearnInCreation. This book can be used for learning purpose and user of this book is prohibited to 

reuse, retain, copy, distribute or republished any content or part of content of this e-book in any manner 

without the written consent of the author or LearnInCreation. 

We continuously build new courses and update content of our website, tutorials or e-books time to time in 

order to build better interactive learning resources for student; however the content may contain error or 

inaccuracies, LearnInCreation provide no guarantee regarding the accuracy or completeness of our 

website or its content, as there is always much more to learn, but if you discover any kind of inaccuracies 

or error in our website, e-books or in any content, please notify us at our mail address. 

learnincreation@outlook.com                                                                                
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Before You Start – 

In this course of Microsoft Office Word - Advance, we dive deep with features of 
Microsoft Word. This course is to learn concept of Microsoft word and create 
professional document with the help of MS-Word Tools and features. We designed this 
course for student and learner or any individual who willing to learn Microsoft Word for 

career enhancement.   

Table of Content – 

 Introduction 

 Working with Paragraph 

 Cut, Copy & Paste 

 Paragraph Spacing 

 Line Spacing 

 First Line Indent 

 Header & Footer 

 The Designing Tab 

 Show & Hide 

 Insert Date & Time 

 Insert Page Number 

 Indent and Tab 

 Indent Marker 

 Tab 

 Add or Remove Tab 

 Alignment of Text 

 Drawing Different Shapes 

 Find & Replace 

 Font 

 Sub-script & Super-script 

 Strike Through 

 Use Spell Checker 

 Textbox & WordArt 

 Hyperlink 

 Add E-mail in document 

 Style & SmartArt 
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Introduction 

In earlier day‟s computer are developed just to process number or to do 
calculation. Soon, it‟s become very useful in manipulating and process the text 
document such as – letter, notes etc. 
 
And due to continuous improvement in processing text, today it‟s a widely 
used and also an important feature of computer application named as Word 
Processing. Word Processing is a software which is used to write and edit 
letter, article, documentation, adjusting of font and format, rearranging 
sequence, correcting the error. 

Microsoft word processing is a program designed on “WYSIWYG” principle. 
WYSIWYG is stand for „what you see is what you get‟ means page which is 
visible on your screen is in same pattern as it would be after printing. 
Microsoft is continuously upgrade its MS- office, so it‟s good to you that 
always upgrade your knowledge and skills. 
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Working with Paragraph – 

It‟s really important to give an importance to your text. If you want to create 
better documentation then it‟s a good practice to working with space between 
two paragraphs or between two lines, in order to make them clearly visible 
and readable for better understanding. 

So under this section you are going to learn working with paragraph, how to 
give right format to paragraph, you read about space before and space after, 
and also about line spacing. Let‟s learn one by one – 

Cut, Copy and Paste – (Best Tool) 

You can cut or copy the text somewhere from the document and paste it 
elsewhere. When you cut or copy the text from somewhere its stored in 
clipboard until you didn‟t cut or copy another one. 

Copy command is used to create duplicate text or image. Let suppose you 
need a same image, three times in a document so it‟s a better way to copy 
your image and paste it in desired place rather than inserting it every time. Or 
you need a sentence from first paragraph again in a last one so it‟s easy to 
copy it rather than typing it again. 

While Cut command is used when you no more need a text or images in an 
earlier place so you can cut it form there and paste it in its new place. 
 
To Cut, Copy or Paste your text or Image just select it and then – 

1. Either cut, copy or paste it by clicking on cut, copy or paste command in Home 

menu on Left corner of window. 

2. Or Right click on your mouse after selecting your image or text to cut, copy or 

paste. 

3. Easiest way to cut, copy or paste your text is using shortcut key. Cut – Select text 

and press Ctrl + X. 
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Copy – 

Select text or image and press Ctrl + C. Paste – To paste your text simply 
press Ctrl + V. 

Paragraph Spacing – 

When you complete one paragraph in Word, you simply press Enter key to 
change the paragraph, by default, Enter key helps you to change the line and 
cursor moves to next line with some space. 
 
It‟s a space between two paragraphs which was set by MS-Word itself, by 
default. You can maximize or minimize this space between two paragraphs as 
per your wish or requirement. 

Adjust the Paragraph spacing – 

MS-Word allow you to increase or decrease the space before or space after 
as per your requirement. 
 
Space before indicate the space you assigned before the paragraph while 
space after indicate the amount of space you give after the paragraph. 

Follow these steps to adjust the space – 

1. First select the paragraph you wish to format. 

2. Click on Line and Paragraph spacing in Home tab (under paragraph section). 

3. Select the paragraph spacing you wish to assign to your paragraph. 

4. You can also Add Space before Paragraph or Remove it after it. 
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To set space before and after the paragraph or between lines (for more 
control on paragraph spacing and line spacing) you can select Line Spacing 
Option from the drop down list of Line and Paragraph Spacing. 

On clicking Line Spacing Option a new dialog box is open with more option 
and gives you more control over spacing. 

 

What is Line Spacing – 

Line spacing allows you to set spacing between lines within a paragraph. Let‟s 
do this small exercise for practicing Line spacing – 

Write some text and make a paragraph of minimum five lines. Next select the 
entire paragraph and follow these step and observe the difference – 
 

1. Click on Line and Paragraph Spacing under paragraph section in Home tab. 

2. Select the Line Spacing Option. A new dialog box will open. 

3. Under spacing section in Indent and Spacing tab choose line spacing and click 

on drop down menu to adjust the line spacing. 

4. Select 1.5 from list and click on apply and close the dialog box. 

5. Now observe the difference. 

6. Rest of the option will also work in same manner and provide a line space within 

paragraphs. 

Now after learning paragraph spacing and line spacing, next you learn about 
Indent and Tabs, here is a short introduction about indenting first line. Rest 
you will learnt in separate topic of Indent and tabs after Header and Footer 
section. 
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First-line indent – 

It‟s generally used to indent the first line of paragraph, if needed. 

There is a small exercise, practice it to understand what actually first-line 
indent do with paragraph and how it‟s helpful to you. 

Write a short paragraph of minimum eight to ten lines and follow these steps – 

1. Select the entire paragraph. 

2. Select the Line Spacing option from Line and Paragraph spacing under paragraph 

section. 

3. A dialog box will open, under Indent and Spacing tab choose drop down menu under 

Special. 

4. Select the “First line” and if you wish then set the space you want to give for indenting 

under “By:” field, and observe the difference. 

5. Choose “none” from list to remove the indenting. 
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Header and Footer – 

After working on a paragraph it‟s a time to read or learn about Header and 
Footers. Header is a section of the document located in upper or top margin, 
while lower or bottom margin is sectioned under Footers. 
Header and Footers are used to formatting document so its gives some 
additional knowledge about date of writing documents, who wrote it (author‟s 
name), page number etc. and also makes a document easy to read. 

Let‟s follow these step to create a Header and Footer – 

1. Place your cursor on the top of the page or on bottom and double click 

anywhere. 

2. Header or Footer will open and you see a blinking bar to type your text under 

section. 

3. Also you see a Design tab appears on right side of Ribbon bar to customize it. 

4. Once you type your text under Header (like documentary name or topic, its types 

etc.) or Footer section (like author name, page number etc. in footer), click on 

“Close Header and Footer” button or press Esc key. 

5. The text will appear on header or footer section. 

If you are confused about Header and Footer section format or customizing 
then, there is a tool present in MS-Word helps you to do it in simple way. 
There is a many formats present in Word you just need to choose and insert it 
in your document. 

To insert Header and Footer follow these simple steps - 

 Go to Insert tab and click on Header to insert header and on Footer to insert 

footer in a document. 
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 Now choose a desired template of header and footer and select the one you like 

the most. 

 Now to edit the content of Header and Footer just click on the dummy text and 

edit it with your text. 

 Press Esc key to close Header and Footer and your content is still there which 

makes your document easy to understand. 

 If you wish to edit your footer again so go to footer section in your document and 

double click there to unlock it and change or edit text. 

 Similarly you can also edit the Header section. 
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Removing or Hide Header & Footer – 

If you want to make your first page (cover page) differ from rest of the 
document, then you can hide header and footer section in first page, goes to 
Designing Tab and click on Different First page check box. 

If you want to remove all information container in header or footer section then 
simply click on Header command or on footer command and choose remove 
header or remove footer from menu option respectively. 

 

 

Additional Information – 

If you want to add an additional information to your header or footer section 
like date, time, page number, picture etc. then it can be possible with Insert 
command, let‟s check how – 
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The Designing Tab – 

Designing tabs gives you more tools to edit or formatting your header and 
footer and its shows when your header or footer section is unlocked. There 
are many tools in designing tabs allow you to remove or hide header or footer, 
additional option are also being open to add on the header or footer section. 
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Show & Hide – 

There are so many tools to formatting your documents on MS-Word, one of 
the most used tool in Word is Show & Hide. On enabling this it show you 
every single formatting you done in your document, it also show the hidden 
formatting symbols like Tab, space bar etc. 

To enable it go to your Home menu and under the section of Paragraph click 
on Show and Hide button located next to Sort button. 

Inserting Date and Time – 

So, you want to insert the date or time in your document. This can be done 
with Date & Time command in Insert section. 
Unlock your header or footer section and place the cursor to the point where 
you want to insert the Date & Time. Go to design tab and click on Date & Time 
command. Then follow these steps – 

1. Date and time dialog box will appear. 

2. Select the format of date and time. 

3. If you want to update the time and date in your document, then check the box next to 

Update Automatically. 

4. If you don‟t want to update it then leave it as it is. 

5. Click OK. 

The date and time will appear in document. 

Insert Page Number – 

Now, after inserting date and time, next we will going to insert the page 
number. To insert the page number first you have to unlock header or footer 
section where you want to appear the page number. 
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Then on unlocking it you will see the Design tab in Ribbon. 
Click on it and follow these simple steps – 

 

1. Click on Page number command. Click over drop down menu and select the Current 

position and choose a styling. 

2. Page number will be appear, if you want to edit it‟s font, font size, alignment etc. then 

select the page number and goes to Home Tab and formatting its font size, alignment 

etc. 

3. After customizing it, press the Esc key. 

It‟s a method of inserting page number on Current position. You can also 
directly insert page number on header and footer just by selecting Top of 
Page and Bottom of Page under Page number command. 

 

Poonam message – 
 

So, you almost cover half of your journey to being a professional. There is 
little more topics you need to learn and then you are a smart Word‟s users.  

If you feel difficult to go forward with this course, you should first go with our 
„Beginner Course‟ so it‟s helpful for you to amplify your MS- word skills. Don‟t 
forget to read them. 
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Indent and Tabs – 

So, as a promise you are going to learn about Indent and tabs in this section. 
Word Processor allows to indenting text or an entire paragraph, somewhere 
user want to indent only first line as you see earlier to separate it from rest of 
the document. If you want to indent any other line from paragraph except first 
line then it also possible, it‟s called a hanging indent. 

Indenting using Tab key – 

If you want to indent first line in any paragraph then, you can do it simply with 
a Tab key. Place you cursor at the beginning of the paragraph and press Tab 
key. It gives you an indent of 1.5 inch. 
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Indent Marker – 

To use indent more efficiently or in smart way use Indent marker, which gives 
you more control to indent your documents. 

Indent marker located to the left of the horizontal ruler. Enable ruler to view 
indent marker (we already learnt about ruler in previous topics). 
To enable Ruler - Click on View tab and under Show section click on Ruler. 
Here in indent marker you will see three markers. Let discuss each one – 

1. First line indent marker – It‟s used to adjust the first line indent (we discussed 

about it in earlier topic). 

2. Hanging indent marker – It‟s allow the user to indent the line other than first line 

(already discuss in this topic). 
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3. Left indent marker – Indent all lines in a paragraph (moves the both first line 

indent and hanging indent marker). 

You can also indent your paragraph simply, just by clicking on Increase indent 
or Decrease Indent button under Home tab in paragraph section. 

Tabs – 

Tabs gives you more control over text placement inside your documents, on 
pressing tab key it gives you the indent of 1.5 inch on first line by default. 
Depending on the cursor location tab key either create a first line indent or 
add a tab. If placed at the beginning of paragraph it gives a first line indent 
otherwise add a tab when placed in between the paragraph. 

On the top of the window on left side at vertical ruler you will find a tab 
selector, which allow you choose different types of tabs. 

Types of Tabs – 

1. Left tab – 

Align the text to left at the tab stop. 

2. Center tab – 

Center the text. 

3. Right tab – 

Align the text to right at the tab stop. 

4. Decimal tab – 

Align decimal number using decimal point 

5. Bar tab – 

Allow to draw a vertical line on document. 
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6. First line indent – 

Indent first line of paragraph. 

7. Hanging indent – 

Indent any other line from middle of the paragraph except first line. 
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How to Add and Remove these Tab – 

First select the paragraph to apply a tab over it, unless it will apply on either in 
the current paragraph or in a new one. Now let us understand the Adding of 
tabs through a small exercise – 

1. Create a small document of at least one paragraph. 

2. Select the entire paragraph to add the tab on it. 

3. Goes to tab selector click on it to select the Left tab. 

4. Select the location on horizontal ruler bar where you want your text. 

5. Now, place your cursor at beginning of paragraph and press Tab key. 

6. Text will jump to the assigned location.  

Now to remove the tab simply click and drag it from ruler. Similarly you can 
also add others tabs in your documents. 
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Poonam Message – 

Hey! So you learn more about formatting paragraph through Indenting and 
Tab. Good! Now it‟s a time to learn about Text Alignment. 

 

Alignment of Text – 

Alignment of text to its right position or according to user requirement gives a 
good appearance to the document. Well, you can align your text to – 

1. Right – 

Align text to the right side of page. 

2. Left – 

Align text to the left side of page. 

3. Center – 

Align text to the center of page. 

4. Justify – 

Align text to both left and right margin. 

To align your text to your desired location you have many ways. Either you 
can do this directly by selecting your text (paragraph) and then clicking on 
Align button located under Paragraph section. 
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Or you can align your text to right by clicking on Line and Paragraph Spacing 
and selecting Right from the dropdown menu under Indent and spacing tab 
(left is selected by default). Similarly, you can align your text to center or you 
can justify it. 

Drawing different shapes – 

Along with picture or images you can also add or insert the variety of shapes 
to amplify your message. Word allow you to add the shape of stars, circle, 
square, arrows and much more. 
 
It‟s simple to add shape in your documents – 

 

1. First click on Insert. 

2. Then on Shapes command. A drop down menu is appeared.  

3. Select the desired shape.  

4. Click, hold and drag it to the desired location to add the shape in the 

documents. 
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To resizing it, first select the shape and then click hold and drag the sizing 
holders, when it appears. You can use corner holder to resizing the shape. 
You can also rotate the shape if you want. To rotate a shape you must click, 
hold and drag the rotator lever. 

To change the Order of Shape – 

Sometimes, in some places you need to insert more than one shape. So in 
that case shape will insert on one another and overlap each other. In order to 
put them in right manner you need to change the order of shape to moved it in 
front or in behind. There are some step you need to follow – 

1. Right click on the shape you want to move. 

2. The menu will appear, selected an option from listed one (here we bring the 

shape in front). 

3. The Order of the shape will change. 

4. For ordering multiple shapes, which are overlapping each other it‟s difficult to 

select them individually so use the Selection pane, which allow you to select and 

drag the shape to its new position. Selection panel can be access by click on 

“Selection pane” on “Format” tab. 

Find and Replace – 

The “Find” command helps us to find specific word from the text. Also if in a 
documentary project you just misspelled any word which comes repeated 
times so it a long path to figure out it manually and delete and then type the 
correct one. So in that case it‟s good to use “Replace” command. 
 
So follow these steps to find out and to replace the specific word or text. 

Find – 

To find a specific word or text – 

1. Select the entire paragraph or document where you wish to find out. 

2. Click on Find button (located in upper right corner in Home menu). 
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3. Type your word you wish to find out. 

4. Click on „Find Next‟ (help to see or highlight the same word written on another 

place.) 

There is an another way to find out the word from para – 
 

1. Press Ctrl + F key to activate find command. 

2. Type a specific text you wish to find. 

3. Follow the button “Find Next” if you want to figure out the same word in entire 

documents unless close the dialog box. 
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Replace – 

So above you read about finding specific text or word here you read about 
replacing text or word. There is two method to replace your word or text 

1. Highlight the text. 

2. Click on „Replace‟ command in Home menu. 

3. Type a word in „Find what‟ box you wish to replace. 

4. Type your word in „Replace with‟ box so it can be replace with earlier one. 

5. Click on Replace (If you want to replace it only once in a document.) or Replace 

all (If you wish to replace the word from entire documents.) 

6. Click on Close. 

Second and easiest way to replace your text from document is to – 

1. Press Ctrl + H to open the Replace dialog box. 

2. Enter your word in Find what or in Replace with box. 

3. Hit Replace or Replace all (according to your wish) 

4. Close the dialog box. 

Fonts – 

Fonts make your document, report, letter more beautiful and it must be seen 
clearly. In Word you can customize the font of your document based on sizing, 
styling or appearance like bold or regular, italic or underlines etc. 
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Font Size and Style – 

To change the font size first you need to select text (which font size you want 
to increase or decrease) then either goes to “font size” button in Home menu 
bar and click on drop-down arrow and select the desired size, or right click on 
mouse after selecting text to change its size and style. 

Similarly, you can also change the font style of your document if needed. 
 
To attract an attention on any specific word or sentences either you can make 
it BOLD, Italics, or you can Underline it. To do this you get a button of bold 
(B), Italic (I), underline (U) under font section in Home menu. 
Use them as per requirement in your document, letter, notice or report to 
make its more efficient. 

Sub-script & Super-script – 

In Word, there is also a solution to write a character as a super script (10th ) or 
sub script (H2O). 
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To write super script and sub script character first select the text you wish to 
change as a super or sub script then either click Ctrl + Shift + + (for super 
script) and Ctrl + = (for sub script) or click on x2 and x2 button under font 
section to change it. 

 

 

 

Strike through – 

Strike through is used when you want to mention a wrong text in a document 
with a line cross over it, like – 
 
It‟s not a apple it‟s an apple. 
 
To do this click on strike through command placed before sun script button 
after selecting a text, word or sentence. 
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Use Spell Checker – 

MS- Words also helps you to reviewing your spelling and grammar mistake in 
your documents. With Word spell check tool you can check and correct your 
grammar mistakes. 

Click on Review tab at the top and select the Spelling and Grammar button. 
Its helps you to find out misspelled word and shows them in right side panel. 
Place your cursor over it and correct them. Red line under a word show that it 
a spelling mistake and you have to correct it. 

If you are sure that the spelling is right then click on Ignore it button unless 
change it. Grammar mistake are indicated with the help of green or blue line 
under the word or sentence. 

Poonam message – 

Hey! You are focused; it‟s a good learning attitude. So it‟s a time to learn how 
to formatting your text paragraph. And after working on paragraph we learn, 
how to make header of your document. 
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Text Box and WordArt – 

A text box in a document is used to get an attention to specific text. It‟s also 
very useful when you need to move the text in a document. You can format 
the text within text box with the help of WordArt. 

Inserting Text Box – 

1. Place the cursor at the point of inserting a text box. 

2. Go to Insert tab and click on command of Text box under Text section. 

3. Its shows you the menu with a template of text box, choose any one of your 

choice and select it. 

4. If you want to draw your own text box then, click on Draw Text box option under 

Text box command. 

5. You will get a cursor of plus sign. Click on the document where you want to draw 

a text box. 

6. On clicking you will get a text box, you just need to adjust its size (resize) by 

dragging on its sides and corners knob. 

7. Type your desired text one you done with adjusting a size. 

8. Change the font, size, color etc. of your text after selecting it. 

9. You can also use the WordArt to format your text. 

10. A new tab of Format is appear which allows you to do more editing with your text 

and text box. 

11. Once you finish your editing, click outside the box. 
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You can change the position of your text box just by moving it within a 
document, to move your text box place your cursor at the edge of text box and 
its change to the plus sign with arrow. Click, Hold and Drag the cursor to your 
desired location. 

Hyperlinks – 

Hyperlink is used to create a link of websites and email address which can 
directly access from document. Hyperlink are created with the help of two 
things – 

1. Address (address of webpage or email address). 

2. Text (Text of link you want to display). 

Read this given example – 

 

If you are creating a document and you need to add your e-mail address for 
any question or queries, so your e-mail can be input as –  

youremail@example.com (address) but if you want to display some text like - 
mail me instead to full web or email address then it can be done by using 
Display text. 

If you don‟t want to use display text for web addresses or email then you 
simply add the hyperlink just by typing your web address and hit the 
“Spacebar”. 
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If you want to insert Hyperlinks then follow these simple steps – 

1. Go to Insert tab and click on Hyperlink under Link section. 

2. A new insert dialog box will appear. 

3. Here on bottom you will add the web address. 

4. Text you want to display is written in Text to display field at top. 

5. Click OK. 

6. You will see your web address wrap under a text you wish to display. 

Don‟t forget to Mail Us your suggestion and feedback, they are valuable for us. 

Adding e-mail address – 

1. Open the Insert dialog box, by clicking on Hyperlink under Insert menu. 

2. On left side navigation click on E-mail address to add your e-mail. 

mailto:learnincreation@outlook.com?subject=Hey!%20Learnincreation%20Geeks,%20I%20have%20suggestion%20for%20you%20!
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3. Type your email under e-mail field and input the text under text to display. 

4. Click OK. 

5. Your e-mail added to your document. 

There is a short-cut key to open a Hyperlink insert dialog box, press Ctrl + K. 
It‟s a good practice to text your hyperlink after inserting it. If it‟s linked to a web 
address then your browser will open on clicking on link. If it doesn‟t open then 
it simply means that address is miss-spelled. Well in this case you can Edit or 
Remove your hyperlink. 

To Edit or Remove hyperlink follow these steps – 

 Select you link. 

 Right click on it. 

 It shows many option find and click on Edit to edit your link or you can remove it. 

 

Poonam message – 
 

Now you can add your email in your resume at the top of document to provide 
them convenience to mail you offer letter. 

Style – 

Style is used to give a better appearance to your document; actually a style is 
a predefined set of font style, color, size and rest of formatting. So you don‟t 
need to format a document, you just need to select the one style option you 
desired to give to your document, and it gives a new appearance to your 
document. 

Now, the next question is how to apply it? Since styling your document is an 
important feature, also it‟s a very easy way to format your document with your 
desired style, so it‟s necessary to know how to apply it. There are some steps 
given below you used to applying style in your document. 
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1. Select the text you want to format. 

2. In a Styles section under Home menu choose any style of your wish. 

3. For more styling option click on drop down menu, its open a many styling format. 

4. Select any of your choice and you will see your text will format as per style your 

selected. 

 

 

Poonam message – 
 

Hey! Are you enjoying our courses, if yes then gives us like on Facebook and 
give us your feedback? 

 
So, you learn to add email in your document. You learnt how to styling your 
document. Now it‟s a time to add some graphics in your document instead of 
boring text, and for this next you are going to learn about SmartArt. 
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SmartArt – 

Are you getting bored due to this boring text document, well it‟s a time to add 
some graphics in your documents, which makes your document more 
attractive and interactive while reading. 
SmartArt is again a very nice tool of Word, which allow you to use graphics 
instead of text to communicate with reader who is reading your document. So 
it‟s a good tool which makes your document friendly to read. 

How to insert SmartArt? 

Well you ask a valid question, and in a next paragraph you will get a steps to 
insert it in your document. So follow these simple steps and learn to speak in 
a language of graphics. 

1. First place your cursor to the position where you want to add a graphics in your 

document. 

2. Second, under an Insert menu you will see a SmartArt command. 

3. On clicking on it, a new dialog box will appear. 

4. On left side you will see a category, select any one of your choice. 

5. Next, you see a SmartArt graphics on right side panel, find the one which you like most 

and select it. 

6. Click OK, and it‟s appearing in your document. 

7. Now simply edit it as per your desire. 
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Poonam Message – 
 

So it‟s all about SmartArt, SmartArt is very useful tool to make your document 
more attractive and reader interactive. It‟s a method of saying your word 
through graphics. 
Want to know more about MS-Word and its tools then don‟t forget to read our 
daily blogs, which helps you to amplify your skills. 

So you are at the end of your document. And you are done with creating, 
formatting and styling your document. It‟s a time to save your first document, 
we already discussed about the method through which you can save your 
document for future and also you can edit it anytime. 
 
 

If you forget then follow these following steps – 
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Saving document – 

 Go to File menu and click on it. 

 A list of option will appear on screen click on Save As. 

 Now select the location where you wish to store file and also give a file name to your 

document. 

 Click on Save or press Enter key. 

There is on more method to save your file, once you completed your 
document and wish to save it then simply press the Ctrl + S, it‟s open a dialog 
box and you just need to write a file name and choose a location and click 
Enter key. 

Want to Edit your file or document? 
Well, if you need to edit your file then, goes to the file location and right click 
on it, and choose edit. 
Like in this picture, file is store in Desktop, so go to file and right click on it, 
and choose the edit option. File will open in word to edit. Or you can double 
click on it to directly open the document in Word. 

 

Note – 

So, we are at the end of the courses and, I hope you learnt much more about 
MS-Word. We continuously build more courses. Don‟t Stop Learning!  

 

 


